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The Contact Import Wizard is the primary vehicle for automated input (import) of contacts and
companies stored in other software packages. MRSware has the ability to take “comma separated
values”-formatted files (an industry standard spreadsheet format) and import the contents to create full
contact and company entries in MRSware.
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Creating the Import File

The file to be imported can be created by hand using any spreadsheet program, or exported from an
existing program into a compatible file format for import. The import file needs to be in comma
separated values format. This format is a standard means of representing data in a file and is compatible
with a number of programs. The following is a short list of the most common programs for contacts, and
references to those programs’ manufacturers to help you get started with exporting your contacts from
their application. For further reference, please refer to the manufacturer's documentation.

Microsoft Outlook
http://office.microsoft.com/en-us/outlook/HP030737641033.aspx

Microsoft Outlook Express
http://support.microsoft.com/kb/270670

Sage Software ACT!
http://itdomino.act.com/act.nsf/docid/13882

Maximizer Software Maximizer
http://support.maximizer.com/

PalmSource Palm Operating System
http://kb.palm.com/SRVS/CGI-
BIN/WEBCGI.EXE?New,kb=PalmSupportkB,CASE=0bj(28734),ts=Palm_External2001

A similar function for exporting contacts from MRSware is available and described in the Contact Export
Wizard User Manual available from the MRSware Documents page via the Help > Documents menu
option in MRSware.

Importing Your Contacts

Now that you have your CSV file of contacts and companies, you can import them into MRSware.

MRSware will automatically create
Company entries for Contacts in your

file and associate them as - Welcome to the Contact Import Wizard

appropriate. For example, if you have 2

three Sales reps that Work for‘ a J This wizard wil guide you through the process of importing conlacts from another program ar
file into MR Sware.

distributor out of the distributor’s [

central office, the import process will
create the distributor’s office as a
Company and link the three sales reps
to that Company.

Contact mport Wizard Ogtions

[l Run the wizard as narmal

Starting the Contact Import © frat wiers s or Unditon by 3 previovs gt |
Wizard

To start the Contact Import Wizard, |

click on the MRSware menu option o]

under File > Import > Contact v

Import Wizard. The Contact Import
Wizard allows the user to both start a

new import and adjust any previous 5 o [ o
imports completed. —

Select the first (default) option to start a new contact import.
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Select the second option to be brought directly to the Contact Options page to adjust a pervious contact
import.

Click Mext > to continue after your selection is made.

Data Source Chooser

Select the file that contains your
contacts (the .csv file) from your
computer by pressing the “...” button
next to the Data File entry text box.

Contact Import Wizard

Data S ource Chooses
Please choose which data sowce type you want to impart and the location of the data file.

Diata File
Icnntad_tes‘t.csv

Infarmation

Thiz format should be used for any standard CSY file thet is not listed
ahove.

Data File Type

Select the file format you are
importing from. The Generic CSV'is
the most general format and will work
with outputs from all programs,
including those listed specifically
below in this list. The Outlook and
Outlook Express CSV file options will
help by matching up fields for you
automatically from those programs in
the next screen. The Maximizer XML
entry will allow you to import contacts
from a Maximizer output file type
called XML.

Generic cortact file CSY

icrosoft Outiook contact file CE%
Microsoft Outlook Express contact file C5W
Maximizer cortact file XML

[ This €S file does not have & header rowe 7

< Back | Mext = | Caneel |

Your file should have a header row if
possible — a header row is the first row of the file that contains the description of each column in the file.
Some programs do not put out a header row, so MRSware has been designed to handle this situation. If
your file contains no header row (you can open the file and look at the first row to determine this), then

select the This CSV file does not have a header row option. This option will provide you a chance to

name the columns for correct
matching of data during the import
process.

Set Mappings

Now you must set the “Mappings” to
match up the column names from
your import file to the fields in
MRSware were the corresponding
data should appear. The Contact
Import Wizard does its best to match
up the field names where they have
similar names, such as First Name or
Job Title. In many cases the column
names you are importing may be
significantly different in name then
where you want the data to show in
MRSware. For these cases, select the
column name from your file on the
right that matches to the MRSware

Contact Import Wizard

SetMappings

Flease choose how the MRSware contact fields [left] will map to the figlds found in the data source
[right].

General |Addresses I Advanced

Full Cortact Mame fignorecd)

First Mame First Mame

Miclcle: Mame Miclclle: Mame:

Last Mame Last Mame

Company Mams Company Mame

Contact Type fignorecd)

Salutation (ignorec)

Prefix (ignored)

Sz Suffix

Job Title Job Title

Business Phone Business Phone

Buziness Fax Buziness Fax

Home Phone Home Phone

Mohile Phane dnhile Phans

SO [

Loz Magp Save Map

I Next = I

= Back

Cancel

field name listed on the left. For example, Business Phone in MRSware (as listed on the left side) may

match up to 7elephone 1 in the file you are importing; select 7elephone 1 from the drop-down selector
on the right where Business Phone is listed on the left.
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Once you have your mappings set correctly, you can save them for future use. Press the Save Map
button to save the mappings. To load mappings in the future, use the Load Map button and select a

saved map file.

Be sure to also make the correct
associations on the Addresses tab for
the various addresses of the
companies and contacts.

The Advanced tab has an additional
option which is commonly used. If
your file being imported contains a
column with a comma separated list
of categories in it, this information can
be imported and assigned
appropriately in MRSware during the
import process. An example of this
would be if you had your contacts
designated by market segment in your
previous contact management
program and would like to import this
information into MRSware.

Press the Next > button once all the
mappings are complete.

Contact Import Wizard

SetMappings
Pleaze choose how the MR Sware contact fields (left) wil map to the fields found in the data source
[right].

Generall Addresses  Advanced |

Unicjue Prefix I(\gnored)
Uricyue 10 I(ignnred) j
Categories fig

Unigjue 10 A& walue that uniguely identifies the contact within the file

Unigue Prefix A value that will ensure the Unigue 1D becomes unique for your entire company

Categories A comina seperated list of values that will be added as categories

Unigue D Help

Loz Map Save Map

I Next = I

< Back Cancel

Categories and Additional Info

Any fields which did not get assigned
to a MRSware field in the previous
mapping stage are available at this
point to be created as Additional
Information items or Categories. This
dialog allows the user to select which,
if any, of these fields they would like
to import as such.

Check off any columns in the first
selection area to be created as
Categories. The option Prepend field
name to category name will add the
name of the column to the Category
in MRSware. For example, if the
column name is Buying Group, the
entry in MRSware would show as
Buying Group:: followed by the value
of the column, i.e. Buying
Group.:Northeast Distributors.

Contact Import Wizard

Categories and Additional Info

The fields below were unmapped, pleaze chooze which fields you would ke to add as categories
or additional info.

Add the following checked fields as categories:
[[] Created On

[ Last Madified

[ system Type

[ Title

u Prepend field name to category name

Kl -]

Add the following checked fields as additional
[[] Created On

[ Last Madifisd

[ System Type

[ Title:

Kl L]

I Mext = I

< Back Cancel |

Check off any columns in the second selection that are to be created as Additional Information items.

Press the Next > button when all desired fields have been selected.

Contact Import User Manual
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Set Merge Sensitivity

The Merge Sensitivity settings controls how contacts and companies being imported match up against
existing contacts and companies in MRSware. This is the control for the process of how a contact gets
created new or merged with an existing contact.

Typically the System default value is
sufficient for most imports. This
setting matches up contacts and
companies based on name and contact
information like phone numbers and
addresses. If the name, phone
number, or business address does not
match, then the contact will be
considered to be a new one and added
as such. If these fields match between
the existing MRSware contact and a
contact being imported, then the two
entries will be merged. A later step in
the Contact Import Wizard allows the
user to select which value of any
conflicting fields to keep.

U If importing a large database of
o known duplicate entries to those
already in MRSware, where many of

Contact Import Wizard

Set Merge Sensitivity

Please chooze how data conflicts should be handled. If you are unsure what value to uze, leave

Swestem default checked.

% System defautt
' Match against existing contacts
" Insert as new contacts

” Use advanced options (next screen)

< Back

I Mext = I

Cancel |

the entries may have differing names and/or contact information, it is recommended to use the Match
against existing contacts option to let the system know that it should try to match contacts more
aggressively — contacts with near matching names and addresses will now be considered matched more
often — this will greatly reduce the number of duplicates that are create in MRSware. This situation
typically happens when you are trying to merge several separately maintained contact databases into
MRSware (as you would when first moving to MRSware when many different users are now consolidating
their personal databases into a company shared database).

Preprocessing the Import

Preprocessing the import file is like performing a
test run on the data to make sure the results are

as you expected. It is recommended to

preprocess the file whenever an import is done

for the first time.

Select Yes and press the Mext > button to

perform the preprocessing test run.

Prepracess Dptions
Pleass choose whether you would like to preprocsss the fle

Contact Import Wizard

Do you wish to preprocess the file?
@ ves

 ho

during preprocessing

Preprocessing is highly recemmended, especially if this = the first time the file formt is being imported. The resulls can
help you determing if the file is valid or if the data will yield the correct results. Mo data in the system will be changed

< Back

Cancel

I Mext = I
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The file will be uploaded to the server network
and a test run import performed. Once the test
run is complete, the Processing Progress bar will
be completely blue.

Press NMext > to continue.

The next screen of the wizard will show you the
results of your import test run and warn you if
there were a significant percentage of errors. If
there are many errors, please press the < Back
button to go back and adjust the field mappings,
looking for a possible mismatched field. If you
help determining the problem source of an import
file, please contact support@eyond.net for
assistance.

Once you are satisfied with your preprocessing
results, press the Mext > button to continue the
import.

Contact Import Wizard

Confirm Options

Flease ensure the options below are conect. Click Next to begin the import, Back to make
changes or Cancel ta cloze the wizard.

Confirm Options
The Confirm Options page gives the

Contact Import Wizard
Importing D ata

Please wait while the data file is uploaded and processed. The Next button will become enabled
when the import is complete.

File Upload Progress

Processing Progress

Depending on the amourt of activity onthe system, it may take some time for the import to begin. If no processing

progress is taking place, pleass wait several minutes before canceling the wizard. Contact sUpPOM@EYOND net if no
processing has occurred after ten minutes

<Back || nexts

| Cancel I

Contact Import Wizard

Prepiocess Resuls
Eelow are the results of the preprocessing. It is highly recommended that you follow the directions

below,
Poszible records 2
Data Read Results Data Processing Resulls
Processed 2 Complete 2
Errored a Incomplete a
Skipped il

" The file appears to be valid, we recommend that you proceed with the import

= Back

I MNext = I

Cancel

user a summary of what is being done
and a chance to go back and review
the import settings before performing
the import. Click Mext > to begin the
import.

Dt File Name

Drata File Type
Gengtic C5Y

¥ Mote: Clicking Mext on this page wil hegin the import process, bringing in the information from the chosen contacts
file. Please make sure that this file containg correct and up-to-date information hefore proceeding.

CrDocuments and SettingsiLouisidy Documentsihly MRESware Files\contact_test.csy

< Back

I Mext = I

Cancel |

Contact Import User Manual
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Importing Data

Once the import is initiated, the
7 1 Importing D ata
ContaCt flle WI” be uploaded to the Flease wait whie the data fie is uploaded and processed. The Mext button wil become enabled
server network and processing will when the import is complete.
being. The Processing Progress bar File Upload Pragress

will fill blue as the contacts are being
imported. Depending on the size of roessing Progrese
the file being imported (i.e. the EEEERENEEEENENEENENEEEEEEEEEEEEENENENEEEEEN

number Of ContaCtS) ’ thls process may Depending on the amount of activity on the system, it may take some time for the impaort to beain. If no processing

H progress is taking place, please wait seversl minutes before cancelling the wizard. Contact support@E Y OMD.net if no
take some t| me. processing has occurred after ten minutes

Once the progress bar is completely
filled in, press the Next > button.

= Back Mext = | Cancel I

Resolving Conflicts

In some cases the import process will be unable to resolve certain items between the file being imported
and the existing contacts in MRSware. For these cases a confiict is generated. You have the option to
resolve the conflicting items now or come back o them at any time in the future.

To resolve the conflicting items now, select Yes and press Next >.

Contact Import Wizard Contact Import Wizard
Resolve Conflicts? Resolution Type
Ore o more data conflicts or enors has oocured during the import. Choose Yes to resclve them Please choose which type of resolution you weuld like to perform

v of Mo ta resolve them later

Resalve Conflicts? @ Data ftem conflicts (1)

5 ves The system was unable to identify = unique item to update during &n import

~
e " Pending dets updates ( 0 )

Updates thet need user confirmation before they can be saved to the detabase

 Errors(0)
An unexpected situation occurred or & pisce of data needs to be corrected

< Back | Next > I Cancel < Back | Nesxt > Cancel

Data Item Conflicts

The first type of conflict is called a Data item confiict. This is typical of importing a contact where there
are two or more possible matches in the system. Select the Data item confiict type and press Next>to
resolve it.

Contact Import User Manual Page 7 of 11
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The item conflicts will be listed. Select the conflict you wish to resolve from the list and press Next >.

Contact Import Wizard Contact Import Wizard
Item Conflict Chooser Possible Matches

The items below were data items that the system was unable to recognize. Please select an item The table below shows potential matches for the chosen data conflict. Please select the matching
ta identify. data item ar manually edit the data,

Inclex_| ftem [ Title [ Resoution | Selected conflict:  Company

1 Company Unresolved P Imported record

SystemType |Cus10mer ﬂ
Companylame [sabert

JohTile

Title

Micldlehame:

[
I
Firstiame |
I
T =

Possible matches Show: Recommendsd Al
Ief Match % Name Business Phone Business Email Business Address | Hu|
-

23307 100 Sabert
11340 100 Sabert

e

< |

@ Usethe selected match £ addthe data as a new record Do nothing, celete this conflict

<gack [ wextz | cancel | <gack [ mext= | cancel |

A typical conflict will look like the item above, right. This conflict shows that there are two possible
matches for this company already in the database. A number of different circumstances can produce a
conflict like this, such as mismatching contact information, slight naming variations, and duplicate
contacts. Select the appropriate match from the lower list based on the contact information being
imported, which is shown in the upper list. If this is a new contact — i.e. the contact is not matching one
that is in the Possible Matches list — then select Add the data as a new record option. Press the Next >

button when your selection is complete.

The System W||| prompt you to Continue resolving Eng?:;:.immsmed conflict, click Nest. Otherwise click Back to make changes or Cancel to
conflict items and whether to make the same e

choice made here for other conflicts that match T NV

this (now) resolved conflict. " For a ifferert Ketch thet | wil pick

¥ Use this resolution to updste similar conflicts |

% Resalve similar conflicts in the same batch only

€ Resalve similar conflicts in 2l betches

< Back | Nesxt > I Cancel

Pending Data Updates

The second type of conflict is a Pending data update. This is the case of a contact being imported
matching an existing contact in MRSware but having different contact information. The following
resolution process will allow you to select which piece of information you wish to keep. Select Pending
data updates and press Next >.

For this type of conflict, the user is presented with a list of the conflicting items and where the conflict
occurs. For each row in the list, select the item and choose to one of the options by clicking the blue link
at the bottom of the list:

Contact Import User Manual Page 8 of 11
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e Use New Value

Choosing this option will use the value shown in the Mew Value column of the table. This is the

value that was imported from your file.

Contact Import Wizard

Resolution Type PendingData Updates
Plaase chonse which type of resohation you would fke to perfom. Below are the pending data updates for the selected batch, Plaase choose how sach em should
be updated,
" Data item conflicts (0 \ Type | Mame | Field | ey Value | Original Yalug
The system was unable to identify a Unique tem to Update during an import ¥ Cantact Roots & Wings andL... | ContactTypeld Other Customer =l
¥ Contact Seven Arrovwes Eleme... CortactTypeld Cther Customer
' Pending data updates [ 2 )
Updstes that need user confirmation before they can be saved to the database
" Errors (0
An unexpected situation occurred or a piece of data needs to be corrected
4 | o

¥ Uselewvelue ¥ Keep Origingl Valie % lgnore % Cther Help

[¥ Creste system rules to avoid these conflicts in the future

< Back

I Mext = I

Cancel |

<Back |

o Keep Original Value

Choosing this option will keep the value shown in the Original Value column of the table. This is

the value already in existing contact.
e [gnore

Choose this option to leave the conflict unresolved and return to it later.

e Other

This option allows the user to input any value desired instead of selecting either the new or

original values presented here.

all selected at once.

Users can multi-select in this table — as can be done in many of the tables in MRSware — by using the
Shift or Ctrl keys in conjunction with clicking on an item to select it. Group Select: select the first item of
the group, hold the Shift key, select the last item of the group to have all items in the list between the
two selected. Multiple Select: select the first item, hold the Ctrl key, select additional items to have them

There is an option to Create system rules to avoid these confiicts in the future option at the bottom of
the table. This will create an import rule that will cause any future imports that have the same conflict to

be resolved in the same way selected automatically.

The Execute Updates page summarizes the
changes made and gives the user a chance to
return to the previous page and make any
desired changes. Use the < Back button to
return to the previous page. Press Next>when
ready to complete the changes selected.

Execute Updates
To update all the data items and add any nles pou created, click Mext. Otherwize, click Back to
make changes or Cancel to exit

Updstes to execute: 0

Rules to adled 2
[¥ Execute data updates even if original value has changed

[ Resolve addtional ftems

% For the same batch I've already chosen

™ For a different batch that | wil pick

I Next = I

< Back Cancel |

Contact Import User Manual
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Contact Options
The Contact Options page of the Contact Options
. . . The cortacts below were successfully imported or updated. Select ane ar more contacts and right

wizard gives the user the ability to click on the table for aptians.

mark contact and/or companies as [ Private | Hiden | CompanyMame [Title]  FirstWame | MiddleMame | Lastame  [s..| |

Private and/or Hidden, and Assign & O O [Rects &Wings a.. =)

Categories and/or Types. bl L L Seendnowsd

Private

Selecting the Private option will make

the corresponding contact or company

entry only show in your listing in

MRSware. This feature is typically

used when importing a contact that is

personal in nature that you wish to

have in your contacts list but not

necessarily share with other users in B

your company. K — 0
cpack [ mext= | Cancel |

Hidden

Selecting the Hidden check box next to a Company or Contact will cause that entry to be not shown in
the default listing when going to the corresponding shortcut in MRSware. The Hidden entries can be
shown in the listing by selecting Show Hidden from the MRSware menu option. This feature is designed
to help users keep the list from becoming to large to easily navigate and manage.

Categories and System Types

Right-click on a contact (one or multiple) to access the Assign Categories and Assign Types menu
options. These options allow the user to assign either categories of types to the contacts and/or
companies during this final step of the import process. Checking a Category or multiple Categories from
the list will assign that Category to all of the selected contacts/companies. Selecting a Type from the
Assign Types dialog will assign that Type to all of the selected contacts/companies. To add or edit
categories or types, use the corresponding menu option in MRSware under Go 7o > Contact Relationship
Management > Manage Contact.

3Bull Update Categories =13l x| Assign Types

(1) Check categores you want addedto althe selectad contacts, uncheck any categorias you want remaved fromthe sslected

contacts. Shared

Competitar -

[ 1 Advisary Board [] Cartractor [ ] imparts:: MEMRA import 3- [ Lead from £ Eustgmer

[ Agency [ cPFa [ imports:MMS Member Li [ Lead from F Load

] Aliect Mermber [ CPMR [ imports: COPRA 220061 [ Lead from &4

] association: AMG [[] CRM installation [ Independert Consuttart [ Lead from It Dt_hET

] association:: AWM/ [ Customer [ industry:: Food [ Lead from b, Frivvate LI
1 associstion:: AMRA [ Customer service represe [ industry:: Footware [ Lead from b,

[ associstion: AIMRA direct ] Data Erttry Personnel [ industry:: Healthcare [ Lead from b |ndividual

[ industry:: Swimming pools [ Lead from £
[ industry::Electrical [ Lead from v
[ incustry:Foodssrvice disp [ Louis-synck
[ industry::Foodservice equi [] Manufacturs

1 associstion:American Lig [ delete this sntry
[ association: BMC [ Do Mot Email

] association: GHTA [ Employes

[] association:HRA [] Executive Director

Manufacturers Rep
Sales Rep [for EYOMD)

] associstion:IS58 membe [ Featurs request-buyisell (L] industry::Gitt and Trade ] Manufacture
1 aszociation:MAFS memb [ Feature request:hutti Cur - [ industry::Industrial [[] Master Distr
] association::MANS, [ Festure request:Offine (] industry::Jan/San [ mktg mailer
1 associstion:MANA Upstat  [] Feature request:Order en [ industry::Not-Far-Proft [ mida mailer ChmiEan
[vl association:MRA membe [ Feature request-Quotes [ industry::Office products  [v] midg mailer [l
] association: NEMRA [ imports: AMRA 2-16-051 [ industry:Plumbing & hestl [ midg mailer M arnufacturer
[ associstion: MMS [ imports:: American Lightin -~ [] industry:: Technology [ midg mailer Fiep Industy Assoc
[] association: OPRA, [ imports:BMC impart 227 [ Invaice impart : active - i ] midg mailer Sales Agency
1 association:PTRA [ imports:GHTA Members t [ Invaice impart - active - s [ midg mailer. Supplier
] compettar [ imports::M&FS! import 3-1 (] Invoice import = discussin [ mktg mailer
1 Consuttant [w] imports:MRA Impart [ Invaice Impart: Quick Boa [ mitg mailer.
< | |
Reset Ok | Cancel I
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Contact Import Wizard Complete

This completes the Contact Import Wizard. Press the Finish button to complete the changes made and
close the wizard.

Wizard Complete
Congratulations, all steps in the wizard are complete. Click Finish to update the contacts or Back to
mak.e additional changes.

< Back I Finish I Cancel

% This user manual can be downloaded from the MRSware Documents page through the Help >
Documents menu in MRSware.
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